# Table of Contents

**Introduction** .......................................................... 4

Requesting an Emory HR Web Account .......................................................... 4
  For New Accounts ...................................................................... 4
  Changes to Access level for Existing Account Holders ....................... 5
Possible Levels of Access ...................................................................... 6
  Account Restrictions by Employee Class ................................... 6

Software Requirements ....................................................................... 9

Hardware Requirements ....................................................................... 10

Internet Performance ......................................................................... 10

Login IDs and Passwords ...................................................................... 10

Keeping Emory HR Web Data Secure – Logging Off .............................. 11

Emory HR Web Support ...................................................................... 14

Logging In .......................................................................................... 15

Features in Emory HR Web 8.9 .......................................................... 16
  My Favorites .................................................................................. 16
  Menu Search Feature .................................................................... 18

Emory HR Web Functions ...................................................................... 20
  Restrictions to the Use of Emory HR Web within Emory College and the
  School of Medicine ..................................................................... 22
  Restrictions to the Use of Emory HR Web to Update TEC Physician Data .... 23

Online vs. Paper re: TEC Physicians .................................................. 24

View Only Folder Functions ............................................................... 25

Printing HRAFs ............................................................................... 25
  “CHEAT SHEET” for HRAF Printing ........................................... 29

Viewing Job Summaries ..................................................................... 30

Exploring Employee Job History ....................................................... 33
  Accessing Other Job Summaries ................................................ 33

Viewing Additional Pay Data ............................................................. 34

HR Web Reports ............................................................................... 37
  Online Reports ............................................................................ 38
  Running the Reports .................................................................... 39
  Assistance in Using the Reports .................................................. 44

General Updates ............................................................................... 45

PS Financial Lookups ......................................................................... 46

Viewing and Updating Emergency Contact Data .................................. 49

Updating Mailstops .......................................................................... 51
  Understanding Mailstops ............................................................ 52

Updating Pay Location ...................................................................... 53
Viewing and Updating Faculty Data ................................................................. 54
Entering & Updating Future Termination Dates ............................................... 58
Future Termination Processing by Data Services .............................................. 59
Entering Leaves of Absence (Paid/Unpaid) and Returns From Leave .............. 60
Viewing and Updating Personal Data ............................................................... 63
1. Biographical Details (View Only & Update) .................................................. 63
   Name-View Only ......................................................................................... 63
   Birth Information and National Id (SSN) – View Only .................................. 64
   Gender/Educational Level/Marital Status Corrections ................................. 65
2. Contact Information Updates ....................................................................... 66
   To Update an Address Type ....................................................................... 66
   To Add a New Address Type ..................................................................... 68
   Changing the Phone Number/E-mail Data .................................................. 70
3. Regional Tab (Update Access) ..................................................................... 72
   To update information on Ethnicity ............................................................ 72
   To update information on Military Status .................................................. 72
   US Flags .................................................................................................... 73
4. Citizen/Passport and Visa Permit Data .......................................................... 73
   Viewing Historical Personal Data .............................................................. 73
   Changing Employee Location ..................................................................... 74
   Entering Reporting Changes ..................................................................... 77
   Entering Retirements .................................................................................. 79
   Checking Retirements – Approval Status .................................................... 83
Keeping HR/Payroll system HR Web Data Secure – Logging Off ................. 85
HR/Payroll system HR Web Support ............................................................... 88

Special Update Functions ............................................................................... 89
   Payroll & updates to Account Data ............................................................. 93
   Updating Earnings Distribution ................................................................. 93
   Retroactive Changes to Account Data ....................................................... 97
   Pay Rate Changes & Review Data Updates ............................................... 99
   Pay Rate Changes ...................................................................................... 100
   Sample Amt Calc Pay Rate Change & Review Data Update ..................... 103
   Sample % Calc Pay Rate Change & Review Data Update ......................... 104
   Updating Review Data Only ...................................................................... 105
   Retroactive Pay Rate Changes .................................................................. 107
   Terminating an Employee .......................................................................... 108
   Terminations – Approval Status ............................................................... 110

Data Security/User Support ............................................................................ 112
   Keeping Emory HR Web Data Secure – Logging Off ................................ 112
   HR/Payroll System HR Web Support ....................................................... 116
Introduction

Requesting an Emory HR Web Account

For New Accounts

Access to the Emory HR Web online system requires an Operator ID and a Password and approved access for new users of the system - this is a restricted access system. An operator ID and a temporary password will be supplied after account set-up. Your Password may be whatever you designate it to be once the initial security is established.

Emory Healthcare and Emory University employees needing access to Emory HR Web must FIRST submit a Human Resources Data Access Request Form to Emory University Human Resources Technical Services (HRTS).

The form is available at: https://emory.hr.emory.edu/dataaccess

Account Requests must be approved by Authorized Signers for the department/section. Once an account is established, an e-mail confirmation will be sent to the account holder.

All Emory Healthcare employees must also submit an access request via his/her designated Access Coordinator upon receipt of the confirmation e-mail from Emory University Human Resources Technical Services.

NOTE: Training from EUV Human Resources is mandatory for all account holders.
Changes to Access level for Existing Account Holders

In order to change the access level for an existing University Emory HR Web account holder, submit a Human Resources Data Access Request Form to Emory University Human Resources Technical Services (HRTS).

The form is available at: https://emory.hr.emory.edu/dataaccess

Account Requests must be approved by Authorized Signers for the department/section. Once an account is modified, an e-mail confirmation will be sent.

All Emory Healthcare employees seeking changes to their existing access level must also submit an access request via his/her designated Access Coordinator upon receipt of the confirmation e-mail from Emory University Human Resources Technical Services.
Possible Levels of Access

- **Self-Service** (all active employees are given access to own personal data online in Employee Self-Service)
- **Manager Self-Service** (restricted access for viewing training history of direct reports and for use of the Emory Recruiting System – ERS)
- **View Only** (access restricted by dept and employee class)
  - HR Web Reports
  - Additional Pay
  - HRAF Report by Selection
  - Job Summary
- **General Update** (access restricted by dept and employee class)
  - Change Location
  - Emergency Contact
  - Employee Mailstop
  - Employee Pay Location
  - Faculty Data
  - Future Terminations
  - Leave of Absence
  - Personal Data
  - Reporting Change
- **Special Updates** (access restricted by dept and employee class)
  - Pay Rate Changes
  - Earnings Distribution Changes
  - Terminate Employee
  - View Termination Status (for involuntary terminations)
  - Retire Employee
  - View Retirement Status

**Account Restrictions by Employee Class**

Account holders may have access to all employee classes in designated departments OR they may have access to specified employee classes within designated departments. All Employee Classes within a department will be the default level of access.
Emory HR Web Manual

Employee Class Groups

- Principals group includes
  - Employee Class 5 (Board Approved)

- Staff group includes
  - Employee Class 7 only

- Student Employees group includes
  - Employee Class 8 (not FWS)
  - Employee Class W (FWS-Federal Work-Study)

- Faculty Access group provides access to all these:
  - 0 - Faculty @ Rank of Instructor, Associate Lecturer, Special Lecturer, Senior Lecturer, Senior Associate
  - 1 - Faculty above rank of Instructor, Associate Lecturer, Special Lecturer, Senior Lecturer, Senior Associate
  - 2 - Academic Dean
  - 3 - Faculty Equivalent
  - 4 - Librarian
  - A - Adjunct Faculty
  - H - Faculty/Faculty Equivalents without compensation (WOC)
  - V - VA Medical Center Physicians

- Med House Staff (Residents) group includes
  - Employee Class B
  - Employee Class K

- TEC Physician group includes
  - Employee Class Q
  - Employee Class R
  - Employee Class S
  - Employee Class U

- Post-Doctoral Fellow group includes these empl classes

<table>
<thead>
<tr>
<th></th>
<th>Non-degree seeking</th>
</tr>
</thead>
<tbody>
<tr>
<td>9</td>
<td></td>
</tr>
<tr>
<td>G</td>
<td>NRSA Post-Doc Fellow</td>
</tr>
<tr>
<td>L</td>
<td>Traineeships, non-taxable stipend</td>
</tr>
</tbody>
</table>
By requesting a secure account to use Emory HR Web you agree to:

- Never write down or share your LOGIN ID and Password
- Never allow another staff person to use your Emory HR Web account to complete work. Each person using HR Web must have his/her own account
- Never access data you do not have a business need to access
- Utilize all appropriate means to keep the data secure
- Refrain from printing data when at all possible. Printed data should be kept in a secure, locked storage unit with restricted access
- Check the accuracy of all your data entry
- Contact Human Resources Data Services immediately if you make a mistake and request that we delete keying errors. You do not have correction mode. Do not keep re-keying over your mistakes!
Software Requirements

Emory HR Web version 8.9 is optimized for use in Internet Explorer version 5.0 or higher with 128 bit Cipher Strength. To check this, do the following:

Check the following box to be sure your version is 5.0 or higher and you have Cipher Strength 128-bit:

If you do not have a secure version, please contact your local computer support person for an upgrade.

NOTE: Using a browser other than Internet Explorer may affect system performance.
Hardware Requirements

Oracle software performs optimally with the following hardware standard or better: 166 Megahertz, 250 MB. Some software performance issues may be related to your hardware capacity.

Internet Performance

The speed of the system is determined by factors such as user connectivity and network traffic. The system has been designed to handle network traffic from multiple users simultaneously. Please report slowness to the Data Services team immediately.

Clear your Internet Explorer temporary files (cache) regularly to improve system performance:

Open Internet Explorer and click the Tools tab.  
Choose Internet Options 
Click Delete Files (middle of the page) 
Check box “Delete all offline content”  
Click OK 
Click OK  
Close your browser 
Re-open Internet Explorer and sign onto Emory HR Web.

Login IDs and Passwords

Once your access has been confirmed by Human Resources Technical Services via e-mail, log in using your network ID and password.

Emory Healthcare account holders should seek assistance with login IDs and passwords via 8-HELP or (404)778-4357.

Emory University account holders may determine network IDs or ask for a password reset for your LOGIN ID by calling (404) 727-7777.

You may also use the web site below to change a known password. Active employees may modify their ID and password from this page: 
https://password.service.emory.edu/
Keeping Emory HR Web Data Secure –
Logging Off

The Emory HR Web systems will automatically time-out after twenty minutes of keyboard/mouse inactivity. When you are done with your entry, be sure to click “Sign Out” in the upper right hand corner:

You will be returned to the login screen. To make sure no one can hit the back button or see the history of your transactions, click the File Menu in the upper left corner and select “Close”:
If at all possible, create a screen saver password to keep HR Web even more secure:

1) Click Start
2) Select Control Panel
3) Select Appearance and Themes or Display
4) Select Choose a Screen Saver
5) Select 10 minutes
6) Click the Power Button
7) Under Advanced Tab, in the Options Box, Select “Always prompt for password when computer resumes from standby”
8) Click Apply button
9) Click OK
Emory HR Web Support

- To re-set passwords, contact (404) 727-7777.

- To report problems and data entry errors, or receive assistance:
  - Sherry Stodghill, HRIS Specialist III (404) 727-6066
  - Shanterria Baker, HRIS Specialist II (404) 727-0227
  - Shauntae Cleveland, HRIS Specialist II (404) 712-9274
  - Susan Newborn, Manager, HR Data Services (404) 727-7563

- Send HRAFs and forms to: Human Resources Data Services, 1599 Clifton Road, Atlanta, GA 30322

- Campus Mailstop = 1599-001-1AP

- HR Data Services Fax: (404) 727-4008

- For online access to forms and manuals for HR Reps:
  [http://www.hr.emory.edu/eu/managerstoolkit/index.html](http://www.hr.emory.edu/eu/managerstoolkit/index.html)
Logging In

Accessing Emory HR Web
https://psofthr.cc.emory.edu/
(Save to favorites!)

Your home menu:
Features in Emory HR Web 8.9

My Favorites

One feature of Emory HR Web version 8.9 allows users to save favorites within the application. This gives users a shortcut to their most used panels. This feature is similar to Favorites in Internet Explorer. On the main menu, note the link “Add to Favorites” in the upper right hand corner, and the menu item “My Favorites” at the top of the menu.

Navigate to a panel that you would like to save in your favorites such as Special Update>Pay Rate Change.
On the Menu, click **My Favorites** to see what Favorites you have already saved, or to get to the links “Add to favorites” or “Edit Favorites.”

![Menu](image)

Now click Add to Favorites. It populates the Description field with the description of the panel you are saving. You can edit this if you like. Click OK. You could also use the link “Add to Favorites” in the upper right hand corner to add a favorite.

Now if you open My Favorites, you will see the link to the panel you saved:

![Menu](image)

Now if you click that link, it will take you directly to that panel without having to navigate through the menu.
If you would like to reorder your favorites, or delete a favorite, click My Favorites and click Edit Favorites to see the list of the panels you have saved as Favorites. You can assign numbers to the sequence numbers so your Favorites will appear in the order you select. Panel 1 will appear at the top of your favorites. If you wish to delete a favorite, click the delete button next to the panel to be removed from your list of favorites. Click "Save" and the panel redisplays with your favorites in order: Now if you click My Favorites, you will see them in the order you selected.

Menu Search Feature

Emory HR Web has provided a menu search option if you are looking for a panel that you are having trouble locating. At the top of the main menu, note the Search box:

If you wanted to see a list of panels that have to do with Job information, you could search on the word “job.” Type “Job” into the search box.
Click the arrow icon to the right of the Search box. The search feature returns all panels that have content related to the search word.

This search is tied to your user security within Emory HR Web. It will only return panels that you have security access to see within the application. This means that two users who run the same search may not receive the same search results.

Note that the search results show the name of the panel, a summary description of the panel and also the menu navigation to get to that panel. As you are learning the navigation within Emory HR Web, this is a very helpful tool so that you can learn your way to the panels that you need to refer to.

If there are a lot of results for your search, they may be displayed on multiple pages, click “Next” at the top of the results list to see additional results.

From this results panel, you can click directly on the link to take you to that panel. Or you can refine your search, by clicking on the radio button labeled “Search with Results” and modifying your search text. Click Find to see the new results.
Emory HR Web Functions

Online entry is required for:

- Special Update - Pay Rate Changes (with restrictions)
- Special Update - Earning Distribution Changes (with restrictions)
- General Update - Mailstop Updates (for EUV records only)
- General Update - Pay Location Updates (for EUV records only)
- General Update - Reporting Relationship/Supervisor Updates (required entry on all regular staff)
- Special Update - Employee Review Data (required for all regular staff)

All other online entry is optional; departments may continue to send Human Resources Action Forms to Data Services as an alternative.

Online Entry is highly encouraged for:

- Entry of employee terminations
- Updates to future termination dates for students, temps, adjunct or visiting faculty, and those funded via grant contracts
Human Resources Action Forms must be submitted for:

- Hires/Transfers and Rehires (except Emory University student employee hires/rehires who are hired via the HR Web Student Hire System AND hires/rehires hired via Emory Recruiting System - ERS)
- Demotions
- Position Changes
- Reclassifications
- Promotions
- Change in FTE and or compensation for monthly paid staff/faculty
- Status Changes (part to full-time or full to part-time; temp to regular or regular to temp; or a change in FTE)
- Leave of Absence or Paid Leave of Absence due to Family Medical Leave or Faculty Parental Leave
- Terminations of Clinic Physicians or SOM Faculty members
- Death
- Any other changes for which you prefer not to use HRWeb (except for those transactions listed above that are required to be entered online)
Restrictions to the Use of Emory HR Web within Emory College and the School of Medicine

The Emory College Administration Office will continue to manage faculty rank and tenure status updates, termination of regular employees, and retirements. For each of these transactions, continue to forward HRAFs to the Emory College Office. Updating personal data for employees such as address, phone number, email address and emergency contact information may be done by authorized departmental account holders. College departmental account holders may also apply for access to terminate students online.

The School of Medicine will continue to require Dean's office approval for the following faculty actions: earnings distribution changes resulting in changes to all-source salary amounts; faculty data updates; future termination date entry and updates; entry of unpaid or paid leaves of absence and returns from leave; pay rate changes; entry of employee terminations; and entry of employee retirements.
Restrictions to the Use of Emory HR Web to Update TEC Physician Data

If you will be managing Emory Clinic Physician data as a part of your job function, The Clinic Finance office requires that you attend a separate, mandatory class on the relevant policies and procedures.

Current policies and procedures limit HR Web users to the following functions for managing Physician Data:

Earnings Distribution Changes (SmartKey Changes)
   1. Job Summary View
   2. Pay Rate Changes
   3. Personal Data Changes
   4. Emergency Contact Changes
   5. HRAF Report by Selection (printing Human Resources Action Forms)
Online vs. Paper re: TEC Physicians

Online entry is required for:

- Pay Rate Changes on both the TEC Physician and the EUV SOM Faculty employee records with no overall change in total salary (if VA Medical Center salary is involved; must submit HRAF instead)
- Earning Distribution Changes on one job record with no impact to other job records and no change in compensation.

All other changes must be submitted via Human Resources Action Forms.
Printing HRAFs

You will need to print a HRAF each time you need to make a change to existing employee’s data that cannot be entered online. If you need training on the correct completion of Human Resources Action Forms (HRAFS), please contact Human Resources Data Services.

**NOTE:** It is NOT possible to print a HRAF reflecting a future transaction; nor is it possible to print a HRAF for an employee on leave. It is also not possible to print a HRAF for terminated or retired employees.

To access the HRAF printing capability, select the View Only Folder, then HRAF Report by Selection. You will get this page:

1) The system default = today’s date (putting in an earlier effective date will give you a HRAF with historical data).
2) Next, select By Empl Record # by clicking once with the left mouse button. Enter the appropriate empl record number.

3) Type in the Empl ID and Empl Rec # for the Employee(s). If you do not know the employee ID #, click the magnifying glass next to the Empl ID field to search for the ID:

   ![Lookup EmplID](image)

   **Look Up EmplID**

   EmplID: 
   Last Name, First Name: 
   First Name: 
   Last Name: 
   National ID: 

   Look Up  Clear  Cancel  Basic Lookup

   Searching this table may take a long time. Enter values above before requesting Lookup.

If you do not enter an employee record number, the system will default to empl rec 0. If you do not have access to empl rec 0, you will get an error message – “invalid number”.

4) Hit the Tab key once you type in the Empl Rec # and the employee name will appear. Check that you have not entered a typo.

5) If you need a HRAF on other employees, click the + sign to the far right and enter in the next empl ID.

   ![Employee List](image)
6) Once you have entered Empl IDs for all the HRAFs you need, click the “Save” button in the lower left corner.

7) You will get a new page.

8) Click the “Refresh” button in upper right corner.

9) Keep clicking “Refresh” until you see a status of “posted” in the Run Status column on the row for HRHR764A. (If you get a message of “no success”, try one more time before calling Data Services, following the steps exactly as presented.)

11) Click the word details to the right.
12) Select the HCHR764.PDF link (not the log or trc link) to see the HRAF as an Adobe Acrobat (PDF) file. If you do not have Adobe Acrobat installed on your PC, see your local computer support person to have it installed.

13) If you requested multiple HRAFs, you will need to scroll down to see them all.

14) Click the printer icon in the left corner of the window to print. Do not use the Internet Explorer print button.

15) For data security:
   - Close the HRAF window
   - Click “Sign Out” in the upper right corner
   - Close Internet Explorer
“CHEAT SHEET” for HRAF Printing

Getting Started:
- Login to Emory HR Web
- Select: Emory HR Web>View Only>Job Summary to obtain the empl ID & empl record # (see the top of the display to the right of the name)
- Go to Emory Hr Web>View Only>HRAF Report by Selection

HRAF Input Screen:
- The date will default to the current date (if you need historical data, type in the effective date or the “as of” date for the HRAF(s) you need OR click the calendar to choose a different date)
- Click mouse to select empl ID/empl rec # (unless you wish to print a HRAF for all active employee in a dept.) or click the magnifying glass to search for an employee and obtain the empl ID
- Type the first empl ID and hit the tab key (the employee name appears)
- Type the empl rec # (defaults to empl rec 0) – if the record to which you have access is not empl rec 0, you must type in the empl rec number to which you have access, or you are not able to proceed
- Use + and – buttons to the right to add or delete empl IDs from the list
- Click the Save button

Report List Screen:
- Click the yellow Refresh button in the upper right
- Keep clicking until Run Status Column = Posted on the row for the HCHR764 Report
- Click “Details” in the far right of the column of the row for HCHR764

Getting your HRAFS
- On the next screen, click the file name ending in .pdf
- Print HRAFs by using the Adobe Acrobat print icon and not your browser’s print icon

For Data Security
- Close the HRAF window
- Click “Sign Out” in the upper right corner
- Close Internet Explorer
Viewing Job Summaries

Emory HR Web Job Summaries provide a history of all the transactions on an employee record.

Each employee is assigned a unique 7-digit employee ID by the HR/Payroll system upon entry of the hire data. Most employees have only one employee record attached to their employee ID. Students, temporary staff, and student employees typically have more than one employee record. The first record ever entered for an employee is employee record 00.

Emory HR Web users will see only those employees and employee records to which they have been granted access.

To view Job Summary data for faculty/staff select Emory HR Web>View Only>Job Summary.

You are directed to a standard Emory HR Web 8.9 Search page. You may search for an employee by using any of the fields listed.

National ID = the Social Security Number with no dashes.

Key in your search element and click the “Search” button.

If you return to a search screen and wish to see new data, click the “Clear” button, key in your search, and click the “Search” button.
The top part of the Job Summary page looks like this:

<table>
<thead>
<tr>
<th>Campus Mail Location</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Eff Date</td>
<td>06/21/2008</td>
<td></td>
</tr>
<tr>
<td>Campus Mail Loc.</td>
<td>1880-002-1AA</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Primary Dept and Pay Check Location</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Company</td>
<td>EUN</td>
<td>Primary Department ID: 921030</td>
</tr>
<tr>
<td>Eff Date</td>
<td>08/21/2008</td>
<td></td>
</tr>
<tr>
<td>Pay Check Dist Loc.</td>
<td>1980001</td>
<td></td>
</tr>
</tbody>
</table>

Note the Employee ID and Employee Record number in the upper right corner.

Vacation and Sick Balances will only be visible for benefit-eligible biweekly paid employees. Departments are responsible for maintaining vacation and sick accrual/use data on monthly paid employees.

**Most Recent Action on the employee record:**

- **Eff Date** = the Effective Date of the Action
- **Rsn Code** = the Reason for the Action
- **Act Date** = the date the Action was keyed into the system

**Company**

- **EUV** = Emory University employee
- **NIH** = the employee is in a non-taxable position (job codes 9905 and 9901 only)

**Empl Status** = Employee Status

- Active
- On Leave
- Retired
- Terminated

**Salary Grade** – (099 means the position is not classified within a range).

**Std Hours** = the standard number of hours worked per week

**FTE** = full-time equivalency: 40 hours/week = 1.0 FTE; 20 hours/week = .50 FTE; 10 hours/week = .25 FTE
Elig Config 1 = Employee’s benefit eligibility status

- REG = Regular full-time or part-time employee 20+ hours/week and eligible for benefits
- FT6MO = Full-time temporary employee w/ > 6 month appointment and eligible for benefits
- FTTEMP = Full-time temporary employee w/ < 6 month appointment and not eligible for benefits
- PTTEMP = Part-time temporary employee and not eligible for benefits
- REH RETIRE = rehired retiree
- RTLFT = regular, time-limited full-time and benefit eligible
- RTLPT = regular, time-limited part-time and benefit eligible

Earnings Distribution

An employee’s salary can be charged against the department’s default SmartKey.

Or

When an employee’s salary is split over multiple departments or charged to a department other than that listed on their Job Data then an appointment SmartKey(s) is used.

This box also provides the compensation rate – either M for monthly or H for hourly (biweekly paid employees). This data is critical if you plan to enter updates to either the earnings distribution or the pay rate.
Exploring Employee Job History

In the second half the job summary screen, look at the blue bar titled Job Information. In the upper right hand corner you will see a message that says 1 of #. If the second number is greater than 1, that means that historical job data is available. To access the historical data, click “View All” just to the left of that message to get a scrolling page. To see the less recent data, use the scroll bar on the right to scroll down the view. Historical data will be displayed in reverse chronological order. The most recent will be displayed at the top of the view and the least recent data will be at the bottom of the display.

If you have access to more than one Employee Record for an employee, “Next” or “Previous” buttons will enable you to see the Job Summary data for the other Employee Record under that same Employee ID. You can also see limited job information for a position the employee has with another department.

Accessing Other Job Summaries

To see Job Summary Data on another employee, click the “Return to Search” button, then click the “Clear” button and execute a new search for the next employee’s data.
Viewing Additional Pay Data

Additional Pay is salary received above the compensation rate listed in the job data for the following reasons:

- freshman seminar
- summer research/teaching
- ministerial housing allowance
- compensation above the maximum compensation rate for a pay grade due to seniority - over the range max. (these are processed by HR Compensation staff members only)

Additional Pay Data Functions do not apply to TEC Physician Employee Records.

*Additional Pay is not the same thing as supplemental pay!*

Any additional pay amounts will also be visible in the Job Summary view. To view, select Emory HR Web>View Only>Additional Pay.

To search by name use this format: Last,First (no spaces).

National ID = the Social Security Number with no dashes.

Key in your search element and click the “Search” button.
The Earnings Code indicates the type of Additional Pay(s) applicable to that employee. FRS = freshman seminar; SRT= summer research/teaching; MHA= ministerial housing allowance; and OMX = compensation above the maximum compensation rate for a pay grade due to seniority (over the range max paid in a lump sum).

If the employee is receiving more than one type of additional pay, the top blue bar will indicate 1 of some number >1 such as 1 of 2, OR 1 of 3. If so, use the View All Option or the arrow buttons to see each type of Earnings. Within the display for each earnings code, there will be rows of data in reverse chronological order. The most recent data will be listed first. To see historical data, use the arrow keys to see data by each effective date or click View All to see all the historical data available.

The payment details for a single effective date may have more than one set of data depending on the number of accounts to which the Additional Pay is charged for that effective date and that earnings code. In the display above, Tweety Bird has an SRT Additional Pay effective 08/01/09. The total payment is $1,499.32 per month split between two accounts. The first row of data indicates that $1249.32 will be charged to one account and the second row indicates that $250.00 will be charged to a different account. Note that the second account row is Addl Seq 2 and the first row of account data is Addl Seq 1.
The bottom half of the display provides data from employee record about the base salary and also the account charged for the additional pay. Click the arrow in the tan bar to the left of Job Information to expand the view.

The compensation listed here is the base salary per month. The base salary with the Additional Pay together equals the total gross salary for the time period specified on the Additional Pay Record. Tweety’s base salary is $4572.00/month. In June, July, and August 2009, she also earns additional pay of $1499.32.00/month. Thus, her combined total salary/month for June, July and August 2009 will be $6071.32.

Additional pays can be set up as year-round, or one-time amounts, or as amounts to be paid out monthly for durations less than 12 months.

If an employee has Additional Pay history, it will be visible at the bottom of the Job Summary view.
HR Web Reports

Human Resources Data Services has made a limited number of basic reports available to a restricted group of users via Emory HR Web. If you are authorized for access to these reports, your access to data will mirror your current Emory HR Web access level. For instance, if you have access to an entire Division, you will be able to see report data on the entire division and any department(s) within the division, but you will not be able to see any report data for faculty or staff outside the division.

**NOTE:** Be advised that these reports will be accessing data from the live production version of HR/Payroll system also used for hiring, benefits enrollment, employee data changes, and payroll processing. For that reason, we ask you to refrain from running these reports on biweekly, monthly, or supplemental payroll run dates. We appreciate your cooperation in this matter.

These reports are available under Emory HR Web> View Only Folder>Reports.
Online Reports
In addition to the HRAF, there are currently 11 reports available via Emory HR Web:

Faculty Data Report (HCHR487):
This report returns the following fields: name, employee Id, record, department Id, department, job code, title, regular/temporary, full/part time, class, employee class, hire date, rehire date, sex, ethnic, rank date, faculty rank, track date, tenure track, and status.

Hire, Rehire, Transfer Report (HCHR479):
This report returns the following fields: department, name, employee Id, record, title, grade, effective date, hire date, rehire date, action, reason, regular/temporary, full/part time, category, fte, compensation rate, annual rate, sex, race, from date, and to date.

Job Earning Distribution Report (HCHR476):
This report returns the following fields: name, employee Id, record, department Id, department, job code, title, grade, status, regular/temporary, full/part time, class, hire date, rehire date, frequency, fte, compensation rate, annual rate, smartkey, percentage, % compensation rate, and % annual rate.

Personal Profile Report (HCHR475):
This report returns the following fields: name, Id, record, department Id, department, job code, title, start date, last start date, pay status, employee class, employee class description, regular/temporary, full/part time, group, grad, compensation frequency, fte, compensation rate, annual rate, sex, ethnic, date of birth, supervisor name, and highest education level.

Promotion, Reclassification Report (HCHR480):
This report returns the following fields: department, name, employee id, record, title, effective date, action, reason, code, regular/temporary, full/part time, category, hire date, rehire date, grade, fte, compensation rate, change percentage, rating, sex, ethnic, from date, and to date.

Termination Report (HCHR481):
This report returns the following fields: department, name, employee id, record title, reason, term date, regular/temporary, full/part time, category, hire date, rehire date, rating, sex, ethnic, from date, and to date.

Work Location and Phone Report (HCHR477):
This report returns the following fields: name, department, work location, location, work phone, e-mail, mailstop, and mailstop description.

Leave of Absence Report (HCHR485):
This report returns the following fields: name, Id, record number, status, effective date, action reason, department, title, hire date, length in job, regular/temporary, full/part time, compensation frequency, leave hours balance, and return date.

Future Terminations Report (HCHR486):
This report returns the following fields: name, id, employee, department Id, department, description, employee class, description, future term date, future term reason, and supervisor name.

Performance Review/Supervisory Data Report (HCHR482):
This report returns the following fields: name, id, employee, supervisor name, supervisor id, department name, title, start date, last start date, entry date, regular/temporary, full/part time, compensation, review rating, review date, next review date, and percentage.
Supplemental Payment Data Report (HCPY361):
This report returns the following fields: company, group, pay period end, check date, off cycle, department id, division id, name, earn, description, combo code, sum other.

Running the Reports

1) After selecting the desired report, you will get to this screen:

![Division and As Of Date fields](image)

You may click the magnifying glass next to the Division or Dept field to access the full list of departments or divisions and make a selection OR you may also type in the first few characters of the division or department name (note that Emory HR Web is case-sensitive) and then click the magnifying glass:

Look Up Division

![Search options and results](image)

Make your selection and the division name will populate on the next screen:
Enter the “As Of Date” = “Faculty Data Report for SPH as of _______ date”.
The “As Of Date” will default to the current date. You may change it to a prior date by highlighting the date and typing in a new “As Of Date” for the report.
NOTE: You may not retrieve future data.

Be sure to hit the Save button and you will get this screen:

At this screen, keep clicking on the yellow Refresh Button until the Status for the Report = Posted (Look for the Report Number under Description Column). This report (HCHR478) is still processing.

Click the “Details” link to retrieve report once the status=Posted.
10) The reports will all have XLS extensions, denoting Microsoft Excel format. To use the report, you may save it to your computer to sort, print, or share it by **clicking with your RIGHT mouse button on the file with the XLS extension in the Report/Log Viewer as shown.**
11) Each of the 10 reports is assigned a HCHR### name by HR Web.

<table>
<thead>
<tr>
<th>Emory HR Web Report Name</th>
<th>Common Report Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>HCHR478</td>
<td>Faculty Data Report</td>
</tr>
<tr>
<td>HCHR479</td>
<td>Hire, Rehire, Transfer Report</td>
</tr>
<tr>
<td>HCHR476</td>
<td>Job Earning Distribution Report</td>
</tr>
<tr>
<td>HCHR475</td>
<td>Personal Profile Report</td>
</tr>
<tr>
<td>HCHR480</td>
<td>Promotion, Reclassification Report</td>
</tr>
<tr>
<td>HCHR481</td>
<td>Termination Report</td>
</tr>
<tr>
<td>HCHR487</td>
<td>Work Location and Phone Report</td>
</tr>
<tr>
<td>HCHR764</td>
<td>HRAF Rpt. By Selection</td>
</tr>
<tr>
<td>HCHR485</td>
<td>Leave of Absence Report</td>
</tr>
<tr>
<td>HCHR482</td>
<td>Performance Review/Supervisory Data Report</td>
</tr>
<tr>
<td>HCHR486</td>
<td>Future Terminations Report</td>
</tr>
<tr>
<td>HCPY361</td>
<td>Supplemental Payment Report</td>
</tr>
</tbody>
</table>

12) It is advised that you rename the report to something more descriptive and include the date in the new file name. Once you have renamed the file and chosen the destination location, click the “Save” button.
13) For data security:

- Close the Report List window
- Click “Sign Out” in the upper right corner
- Close Internet Explorer
Assistance in Using the Reports

Human Resources Data Services and Technical Services staff is available to assist you in the use of these reports and in the use of Excel.

For questions, comments, suggestions regarding the content of the reports and for assistance in running the reports in Emory HR Web, contact:

Susan Newborn  
(404) 727-7563  
sjacks2@emory.edu

For questions and assistance regarding Microsoft Excel, contact:  
Peter Buch  
(404) 727-5222  
pbuch@emory.edu
There is no need to submit a HRAF to change employee data if the change is made *and saved* in Emory HR Web.

Remember:

- Utilize all appropriate means to keep the data secure
- Refrain from printing data when at all possible. Printed data should be kept in a secure, locked storage unit with restricted access
- Check the accuracy of all your data entry
- Contact Human Resources Data Services immediately if you make a mistake and request that we delete keying errors. You do not have correction mode. Do not keep re-keying over your mistakes!

**General Update Functions**

- Change Location
- Emergency Contact
- Mailstop
- Pay Location
- Faculty Data
- Leaves of Absence
- Personal Data
- Reporting Change (Who is the supervisor?)
PS Financial Lookups

To find the common PS Financial conversion values for Department #, Default SmartKey, FAS Account and Coda Nominals you will look under Emory HR Web>PS Financial Lookups.

Select the desired conversion option

- Department Id Conversion
- Default SmartKey
- FAS Account Conversion
- Coda Account Conversion
When you select **Department Id Conversion** you will be able to find your former department number and the new value for your department number.

When you select **Default SmartKeys** you will be able to find the Default SmartKey for your department.

When you select **FAS Account Conversion** you will be able to find the 10 digit SmartKey for the former 6 digit FAS Account Number.
When you select **Coda Account Conversion** you will be able to find the 10 digit SmartKey for the former Coda SubAccount.
Viewing and Updating Emergency Contact Data

To view or update emergency contact information, click the General Update Folder, and then click Emergency Contact.

Enter the empl ID; Name (Last, First with no spaces or Last Name only); or National ID (SSN with no dashes). Click “Search”.

1) Click the minus button to delete an emergency contact or click the plus button to update the data.

2) Type in the Emergency Contact Name (Last,First), with no spaces

3) Click the down arrow next to relationship to employee and make selection.
4) Click in the box next to primary contact. If a primary contact is already indicated, you will get this error message:

[Image: Error message in Microsoft Internet Explorer indicating that only one emergency contact can be indicated as the primary contact.]

Select only one emergency contact as a primary contact.

5) If the new Emergency contact has the same address and phone number as the employee, click the mouse in those two boxes. If not, type in the address and scroll down to enter in the phone number.

6) Be sure to click the “Save” button when done!
Updating Mailstops

To update mailstop data for an employee, select Emory HR Web>General Updates>Employee Mailstop.

Search for an employee and click the Search button. The search will produce a page for editing the employee’s data:

1. Click the + button to the right to update the data.

2. Select the desired effective date using the calendar button then the down arrows.

3. Click the desired date.

4. To search for the mailstop number, click the magnifying glass next to the mailstop field to get the lookup page.

5) To assign a mailstop that begins with the number 49, type in 49, click the Lookup button, and retrieve a list.
6) To Select a Mailstop for an employee, click the row of the desired mailstop in the search results view. If you need assistance with determining the correct mailstop code, call HR Data Services.

7) If you know the mailstop, you may type in the mailstop number in this format: ####-#####-#AA where AA = letter, letter

8) Scroll down and click the Save button in the lower left corner. The update will be visible via the Job Summary function in the View Only folder.

Understanding Mailstops

EMPLOYEES MAY HAVE A SEPARATE MAILSTOP FOR EACH EMPLOYEE RECORD WITHOUT AFFECTING PRIMARY DEPARTMENT OR PAY LOCATION.

A mailstop is simply a ten-digit code signifying the location where Emory University Mail Services delivers the mail for a campus building.

Example: Emory College Physics Dept Mailstop

**1131** = building code for the Math & Science Center Building
**002** = second level of the building (*this number should signify the level where Emory University Mail Services drops of the mail for a department in a building, NOT where the employee sits*).

**1AB** = bin number for where Emory University Mail Services staff place the mail bundles, plus a two-character unique identifier for each department with deliveries to that bin, in this case, the Emory College Physics department.
Updating Pay Location

To update an employee’s Primary Department/Pay Location, select Emory HR Web>General Updates>Employee Pay Location.

Search for the employee by name, SSN (National ID), or empl ID and click the Search button:

1) Click the “+” sign to the right to update the data
2) Enter in the effective date
3) Enter the Primary Department Number that is made up of 6 numbers.

Employees may have only one pay location unless there are multiple employee records and one of the records reflects non-earned income (job codes 9901 or 9905). The company for non-earned income is NIH.
Primary Department = pay check/pay advice department.

Searching for Department Numbers and Location Numbers is possible by clicking on the magnifying glasses, but not recommended. Call Data Services if you do not know the number.

If you assign an invalid department number or an invalid location number you will get this error message:

Click the ‘OK’ button in the error message and make the change.

4) Enter the Paycheck Distribution Location number (7 digit location code).

5) Be sure to scroll to the bottom to click the Save button!

6) Go to Emory HR Web>View Only> Job Summary to see the update in the job record.
Viewing and Updating Faculty Data

These screens are used to record whether or not a faculty member is on a tenure track, and how they proceed through the tenure process. It is the department’s responsibility to maintain this data.

To update the status of a faculty member, Select Emory Hr Web>General Update>Faculty Data.

Search for the employee by name, SSN with no dashes (National ID), or by empl ID and click the Search button:

If faculty data is populated for a faculty member, the display will say 1 of 2 or more in the top blue bar. To see the data history, click View All.

1) To update the faculty data, click the + button.

2) If applicable, change the faculty rank. To see choices, click the magnifying glass to the right of the Faculty Rank field.
3) After selecting the rank, type in the effective date for the new rank in this format: MM/DD/YYYY. You may also click the calendar icon to select a date. Use the drop-down arrows to select the month and year, then click the date on the calendar to select that date.

4) Next, to change the tenure track status, click the second + button.

5) Click the drop-down arrows next to the track field to select the tenure track.
6) Enter the new effective date by typing the effective date in this format: MM/DD/YYYY or by using the calendar icon to make a date selection.

7) Click the mouse to indicate whether or not the faculty member has tenure – click either yes, no, or not applicable (if not on a tenure-granting track).

8) Be sure to click the save button in the lower left corner when done!

NOTE: Updating the faculty data will not change the job code or pay rate on the job record – submit a Human Resources Action Form to Data Services to make those changes.
Entering & Updating Future Termination Dates

Future termination dates should only be entered for these types of employees:

1. Student Employees – all Emory University students employed by the University are temporary employees. All student employees are required to be hired via the HR Web Student Hire System. This system requires entry of a job start date and a job end date (future termination date).
2. Emory Temporaries in job codes 9995 (biwkly) or 9996 (monthly)
3. Adjunct Faculty and Visiting professors.
4. Staff (such as Post-Doctoral Fellows) hired via finite grant funding/grant expiration dates.

Search for the employee by name, SSN (National ID), or empl ID and click the Search button:

A future termination date is already in the Emory HR system for Yosemite Sam. It was entered when he was hired as a student employee.

1) To change the future termination date, either type in the new future termination date in this format: MM/DD/YYYY or click the calendar icon to select the new future termination date. You may change an existing future termination date to either an earlier or a later date as long as the date is not earlier than the day of your entry. For example, if you are entering future term data on April 1, the future termination date must be April 1 or later of that year to take effect.
2) To select the Reason Code for the future termination, click the magnifying glass next to Future Termination Reason

FUTURE TERMINATION REASONS
Select G (TMP - End Temporary Employment) for:
- All student employees (job codes 9900, 9998, 9910, 9901, 9905)
- All temporary employees not hired using grant funding (job codes 9995, 9996)

Select L (CNT - End of Contract) for:
- Adjunct and Visiting Professors
- Staff hired via finite grant funding/grant expiration dates.

3) Don’t forget to hit the “Save” button in the lower left corner when you are done! The Job Summary screen will display the update to the Job Record.

Future Termination Processing by Data Services

For those in the student employee job codes (9998, 9900, 9910, 9901, and 9905) and temporary employees in job codes 9995 or 9996, all future terminations will automatically be processed on the date they are effective.

All other Faculty and Staff with time-limited appointments/contracts will have future termination dates. The future terminations will be processed on the first of the month (and then every night in the month thereafter) using an automated process that will pick up whatever effective date is entered. Processing future terminations on the first of the month for these employees expedites generation of both the Separation Notice and the COBRA notice.
Entering Leaves of Absence (Paid/Unpaid) and Returns From Leave

Before keying in leave of absence data, verify if the employee should be placed on paid or unpaid leave.

Paid Leave – the employee has unused, accrued time applicable to the type of leave.

You will also need to verify the date at which the applicable accrued time will be exhausted and the employee leave time must be changed to unpaid leave.

Unpaid Leave – the employee has exhausted all accrued time applicable to the type of leave. These employees also do not accrue time while they are on unpaid leave. They are paid through the short-term disability insurance at 60% pay (if eligible). While on unpaid leave, they also are responsible for/billed for the employee contribution to the benefits deductions.

For questions on policy, please refer to the Human Resources Website at: http://hr55.hr.emory.edu/emoryhr/managerstoolkit/employeerelationship/leaveabsence.html

To place an employee on unpaid leave, paid leave, or return an employee from leave, select Emory HR Web>General Updates>Leave of Absence.

Search for the employee by name (Last,First) w/no spaces or by Last Name only), SSN with no dashes (National ID), or by 7-digit empl ID and click the “Search” button:
1) To enter an update to the employee record, type in the effective date for the update in this format: MM/DD/YYYY or click the calendar icon to select the effective date.

2) Click the magnifying glass next to the action field to see possible Actions:

   **Look Up Action**
   
   **Main Content**
   
   **Action:** begins with ▼

   ![Look Up Action Form](image)

   **Search Results**
   
   View All  First  ▼  1-3 of 3  ▼  Last

   **Action**  **Description**
   
   LOA  Leave of Absence
   PLA  Paid Leave of Absence
   RFL  Return from Leave

   ![Search Results Table](image)

3) Select the Action you desire.
4) Click the magnifying glass next to the Reason Code Field

**Look Up Reason Code**

<table>
<thead>
<tr>
<th>Reason Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADM</td>
<td>Administrative</td>
</tr>
<tr>
<td>DSJ</td>
<td>Medical - Job Related</td>
</tr>
<tr>
<td>DSN</td>
<td>Medical - Non Job Related</td>
</tr>
<tr>
<td>EDU</td>
<td>Education</td>
</tr>
<tr>
<td>MIL</td>
<td>Military Service</td>
</tr>
<tr>
<td>NTT</td>
<td>Non Teaching Time</td>
</tr>
<tr>
<td>PER</td>
<td>Personal</td>
</tr>
<tr>
<td>PRO</td>
<td>Professional</td>
</tr>
<tr>
<td>PRS</td>
<td>Prestigious</td>
</tr>
<tr>
<td>SEA</td>
<td>Seasonal</td>
</tr>
</tbody>
</table>

5) Select the Reason Code.

NOTE: Family Medical Leaves and Faculty Parental Leaves must be submitted on Human Resources Action Forms to Human Resources with the required supporting documentation.

9) Be sure to click “Save” in the lower left corner when you are done!

Your updates are immediately visible on the Job Summary pages.
Viewing and Updating Personal Data

To view or update Personal Data, go back to the Use Menu and select Personal Data.

You will automatically retrieve the same employee’s data. To specify a different employee, click “Search” at the bottom of the page.

Enter in your search element and click the Search Button.

Personal data is divided under five tabs and includes:

1. Biographical Details
2. Contact Information
3. Regional
4. Citizen/Passport
5. Visa Permit Data

1. Biographical Details (View Only & Update)

Name – View Only

Most employees have only one type of name in the database, a primary name. The history of any name changes is recorded under name history. To see all the history for name data for an employee, click the link titled View Name.

<table>
<thead>
<tr>
<th>English Name Format</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Prefix:</strong></td>
</tr>
<tr>
<td>First Name:</td>
</tr>
<tr>
<td>Last Name:</td>
</tr>
<tr>
<td><strong>Suffix:</strong></td>
</tr>
<tr>
<td>Display Name:</td>
</tr>
<tr>
<td>Formal Name:</td>
</tr>
<tr>
<td>Name:</td>
</tr>
</tbody>
</table>
University employees need to notify Data Services as soon as possible after a name change or a gender change. Instructions and forms for name or gender changes are available via Emory HR Web by clicking on “Click to View Name/Gender Change Instructions”.

To change a name in a Human Resources record, the following documents must be completed and signed by the employee:

- Personal Information Change Form with the old and new name
- Updated Form I-9 that verifies identity and employment eligibility as required by the Federal government. Complete the name change section, Section III, of the original I-9 form OR complete a new I-9 (all three sections).
- New Tax Forms, W-4 (Federal withholding) & G-4 (Georgia withholding)
- Copy of new Social Security Card or copy of receipt from the Social Security Administration.

NOTE: Students will also need to change their name in the OPUS System- contact the Registrar’s Office for specific instructions.

Emory Healthcare employees should contact Emory Healthcare HR contacts with changes to personal data.

Birth Information and National ID (SSN) –View Only

Please contact Human Resources Data Services if this data needs to be updated/corrected.
Gender/Educational Level/Marital Status Corrections

You have edit boxes for these data elements if this data needs to be updated/corrected.

- Enter Effective date of the update

Use drop-down boxes to correct gender, educational level, or marital status. Be sure to click the save button in the lower left corner!
2. Contact Information Updates

To Update an Address Type

1. Click the “View Address Detail” link

2. Click on the + button on the next page

3. Type in the correct effective date for the change in this format: MM/DD/YYYY or click the calendar icon to select a date.

4. Type USA in all CAPS (with no periods). To change the country code, click the magnifying address next to the Country field, click the “Lookup” button to make a selection.
5. Click the “Add Address” link

**Edit Address**

- **Country:** United States
- **Address 1:** 2597 Neverending Canyon Road
- **Address 2:**
- **Address 3:**
- **City:** Cartoon
- **State:** GA 
- **County:**
- **Postal:** 30322

6. Type in the address update and click “OK” button.

7. Click the “Save” Button in the lower left corner when done.
To Add a New Address Type

1. Click the + Button next to “View Address Detail” link and you will see a new line with a drop-down box for selection of the Address Type.

   a. Select an Address Type from the drop-down list

2. Click “Add Address Detail” link to the right on the new row.

   Address History

   Address Type: Permanent

   *Effective Date Country *Status Address:
   
3. Type in the effective date in this format: MM/DD/YYYY or click the calendar icon next to the date field to select a date.

4. Type in USA in the country field or click the magnifying glass and then click the “Lookup” button to select a country.

5. Click the “Add Address” link to enter the address:
6. Click the Ok button in the lower left corner
7. Click Ok again
8. Be sure to click Save in the lower left corner!

Mandatory SEVIS (Homeland Security) Reporting of Address Data and Address Updates for All Nonresident Alien Employees

All non-resident aliens MUST provide the following addresses:

LOCAL - this is the Georgia address to which Emory University paychecks and other US Postal Service mailings from campus will be mailed. This address may be an address for a post office box. NOTE: DO NOT specify the address of the employing department. This address is required by Emory University.

PERMANENT - this is the address to which W-2s will be mailed for tax reporting purposes. If no PERMANENT address is specified, the W-2 will be mailed to the LOCAL address.

OTH – nonresident alien employees are required by the U.S. Federal Government to supply a mailing address from the home country.

PHYS - nonresident alien employees are required by the U.S. Federal Government to supply a physical address where they live in the state of Georgia. If this address is the same as the address provided under LOCAL address, this may be left this blank, otherwise, this information required.
Address Types and W-2 Mailing (please read!)

All Emory University employees are required to supply at least one Georgia address for tax reporting purposes. If you enter a Permanent address, this is the address to which the W-2 will be mailed. If you do not specify a Permanent address, the local address will be the address to which the W-2 is mailed. Address changes for W-2s must be submitted by the end of December each year prior to W-2 printing in early January.

Changing the Phone Number/E-mail Data

Scroll down below the address information to see the phone data and the e-mail data.

<table>
<thead>
<tr>
<th>Phone Type</th>
<th>Telephone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>404/655-1214</td>
</tr>
<tr>
<td>Main</td>
<td>404/655-1214</td>
</tr>
</tbody>
</table>

To Change the Phone Number Data:

1. Click the + button to add a new row of phone data and the – button to delete a row of phone data.
2. Select a phone type for that row of data
3. Type in the telephone number (including the area code)
4. Click the Save button in the lower left corner of the display.

NOTE: Changing the address, phone, and email data here will NOT change it in the Student Database. Students must also update all their personal data on OPUS.
To change the e-mail address data:

1. Click the + Button
2. Select an e-mail Type for the new row of data
3. Type in the e-mail address
4. Click the “Save” Button!

Changing the e-mail address here will not update the preferred e-mail address for campus e-mail. That must be done through the IT Helpdesk @ (404) 727-7777. Changing this e-mail address will only change the e-mail address that Human Resources has on file for an employee for HR notices via e-mail.

The BUSINESS e-mail address may not be modified because it is the e-mail address used by the University administrative offices to send employee notices and by Emory University Payroll for multiple purposes:

1. Sending notices about W-2s
2. Sending notices after payroll runs to inform employees that online pay advices are available for viewing
3. Sending notices to biweekly paid employees who have neglected to clock in or out in the timekeeping system
3. Regional Tab (Update Access)

While job candidates are not required to self-identify in terms of ethnic group, the U.S. government mandates reporting of all EEO employers. Thus, all new hires/rehires MUST self-identify re: ethnic group after hire.

To update information on Ethnicity:

Note Checkbox if Hispanic or Latino (new with v. 8.9)

1. Regulatory Region always = USA
2. Enter the change using the magnifying glass to look up choices for Ethnic Group
3. Be sure to click the “Save” button!

To update information on Military Status:

4. Click the + Button first.
5. Next, enter the effective date in this format: MM/DD/YYYY or click the calendar icon to select the date.
6. Enter the changes using the drop down choices.
7. Be sure to click the “Save” button!
US Flags

Anytime you see the US flag in a display, click the arrow to the left to expand the display and see additional data.

In this display under the flag, we see that Petunia Pig has no military service for the Form I-9, she provided a List B document: a GA Driver's License and a List C Document: a Social Security Card. You do NOT need to worry about the I-9 document codes (this data is maintained by HR Data Services)

4. Citizen/Passport and 5. Visa Permit Data

This data is maintained by HR Data Services and the International Students and Scholar Program.

Viewing Historical Personal Data

If an employee has no historical personal data the display will say “one of one” on the far right of the blue bar. If the display says “one of #”, then historical data is available for viewing. Arrow through the history or click “View All”.
Changing Employee Location

Employee Location = the building where an employee works. If an employee moves to a new building, you are required to update this data in the HR/Payroll system. To access this function on Emory HR Web, return to the General Update Folder and select Change Location.

Location Change
Initiate a request to change the location for one or more employees.

Instructions
Follow this process to assign one or more employees to a new location:
1. Enter the date this location change will take effect. You will be able to process only those employees that report to you as of this date.
2. Select/Enter a department number or use the search button to search a department(s).
3. Use +/- to add or delete more departments.

Enter the Effective Date
Enter the effective date for this location change.

As of: 08/25/2009

Select/Enter Departments

1. Enter the date the location change will take place.
2. Type in the department code (6 digits)
Location Change

Initiate a request to change the location for one or more employees.

Instructions

Follow this process to assign one or more employees to a new location:

1. Enter the date this location change will take effect. You will be able to process only those employees that report to you as of this date.
2. Select/Enter a department number or use the search button to search a department(s).
3. Use +/− to add or delete more departments.

Enter the Effective Date

Enter the effective date for this location change.

As Of: 08/25/2009

Select/Enter Departments

<table>
<thead>
<tr>
<th>Department</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 00000</td>
<td>HR Administration</td>
</tr>
<tr>
<td>2 113040</td>
<td>Financial Operations: Payroll</td>
</tr>
</tbody>
</table>

3. Click the + box to add another department
4. Click continue when all departments relative to the location change have been entered – you will retrieve a list of all the employees in those departments to which you have access (those who “report to you”)
5. Select the checkbox next to the employee name(s) of those relocating (if there are too many to display on one page, scroll to the top of the page to the blue bar and click the arrows to navigate to the next page to select more names

All the employees selected must all have the same new location to use this method of entry.

6. Click "Continue" when finished selecting employees
Change Location

Below is the list of employees you selected for a location change. Click Submit once you have entered the location change information.

### Selected Employees

<table>
<thead>
<tr>
<th>Name</th>
<th>Job Title</th>
<th>EmpId</th>
<th>Current Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Katherine Hinson</td>
<td>Dir, HR Communications</td>
<td>0365025</td>
<td>1599 CLIFTON RD</td>
</tr>
<tr>
<td>Laura Cox</td>
<td>Supv, Payroll</td>
<td>0375464</td>
<td>1599 CLIFTON RD</td>
</tr>
<tr>
<td>Elmer Fudd Jr</td>
<td>Temporary Employee</td>
<td>9999907</td>
<td>MATERIEL CENTER</td>
</tr>
</tbody>
</table>

### New Location

**Date Change Will Take Effect:** 08/25/2009

*Location:*

* Required Field

[Submit]

Is this date correct?? If this is NOT the correct date, click "Return to Select Employees" and follow the instructions for changing the date.

7. Enter 7-digit location code for new location, click "Submit".
8. Click "Submit" and a confirmation screen will summarize the entry. The updates will be visible on the Job Summary Screen as DTA/LOC – Data Change, Location Change.
Entering Reporting Changes

This is a required function on Emory HR Web. To enter data on reporting relationships (who supervises who), return to the General Update Folder and select Reporting Change.

**Reporting Change**
Initiate a reporting change for one or more of your employees.

**Instructions**
Follow this process to assign one or more employees to a new supervisor:

1. **Enter the date the reporting change will take effect.** You will be able to process only those employees that report to you as of this date.
2. **Select/Enter a department number or use the search button to search a department(s).**
3. **Use +/– to add or delete more departments.**

**Enter the Effective Date**
Enter the effective date for this reporting change.

As of: 08/25/2009

<table>
<thead>
<tr>
<th>Department</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>113040</td>
<td>Financial Operations, Payroll</td>
</tr>
<tr>
<td>160000</td>
<td>HR Administration</td>
</tr>
</tbody>
</table>

1. Enter the date the reporting change will take place.
2. Type in the department code (6 digits)
3. Click the + box to add another department
4. Click continue when all departments relative to the reporting change have been entered – you will retrieve a list of all the employees in those departments to which you have access (those who “report to you”)

Page 77 of 116
5. Select the checkbox next to the employee name(s) of those with reporting changes (if there are too many to display on one page, scroll to the top of the page to the blue bar and navigate to the next page to select more names)
6. Click "Continue" when finished selecting employees

All the employees selected must all have the same supervisor to use this method of entry.

7. Check the effective date for the reporting change on the next screen. If the date is incorrect, click “Return to Select Employee” to make the correction.
8. If the effective date is correct, you may now specify the new supervisor.
9. If you do not know the supervisor’s empl ID, you may click the magnifying glass to search for the supervisor by name.
10. Be sure to click “Save”
11. You will receive a confirmation page of all those employees updated.
12. The updates will also be visible on the Job Summary page for each employee with the effective date specified and Action Code DTA (Data Change) and Reason Code USI (Update Supervisor ID).
Entering Retirements

EMORY UNIVERSITY RETIREMENT POLICY
Emory offers benefit-eligible employees the ability to continue certain benefit programs into retirement.

ELIGIBILITY
Those eligible for retirement benefits include benefit-eligible, regular employees, principals, and faculty who work at least 20 hours or more per workweek, and:

- Are at least age 55.
- Have at least 10 years of service of at least half time with breaks not to exceed a 12-month period.
- Are retiring from a paid status or a disability Leave of Absence.
- Total years of age and service equal at least 75.

Eligibility is determined by HR Benefits Specialists as part of this automated process.

An employee’s departure will only be reflected as a Retirement in the HR/Payroll system if the employee is eligible for retiree benefits from Emory University. Otherwise, the employee’s departure is listed as a termination.

To enter a retirement online, return to the Special Update Folder and select Retire Employee.
Once you have selected all the necessary depts. with employees retiring on the effective date specified. Click “Continue”.

Select all the employees retiring. If the result set for the depts. requested is greater than the display limit, you will not be able to see the full employee list displayed on one page. If so, scroll up to the blue bar and navigate to the next page(s).

All the employees selected must all have the same retirement date to use this method of entry.

Click "Continue" after you have selected all the employees.

You will see the next page:
Retire Employee

Retirement Details

Tweety Bird

*Effective Date* is the first day the employee is no longer employed at the company.

Click "Submit" once you have entered the retirement information.

<table>
<thead>
<tr>
<th>Retirement Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Retirement Date: 08/25/2008</td>
</tr>
<tr>
<td><em>Reason for Retirement:</em></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Current Info</th>
<th>New Info</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Department:</strong></td>
<td><strong>HR, Retiree (HR Use Only)</strong></td>
</tr>
<tr>
<td><strong>Location:</strong></td>
<td><strong>Emory University Location</strong></td>
</tr>
<tr>
<td><strong>Pay Group:</strong></td>
<td><strong>Retired University</strong></td>
</tr>
</tbody>
</table>

*Required Field

Return to Select Employees

Return to Special Update

If the effective date is incorrect, click Return to Select Employees link in lower left corner to correct.

If the effective date is correct, review the selected employees. If the selection of employees is incorrect, click Return to Select Employees link in lower left corner to correct.

If all is correct, click the “Submit Button”
The Submit was successful.

<table>
<thead>
<tr>
<th>Role Name</th>
<th>Name</th>
<th>Action Taken</th>
<th>Date Entered</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Originator</td>
<td>Sherry McKenzie Stodghill</td>
<td>Submitted</td>
<td>08/25/2009</td>
<td></td>
</tr>
<tr>
<td>EU Retirement Approver</td>
<td>Amanda Haas</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EU Retirement Approver</td>
<td>Arny Watkins</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EU Retirement Approver</td>
<td>Cindy Mayz</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EU Retirement Approver</td>
<td>Emily Blackwell</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EU Retirement Approver</td>
<td>Frances Reese</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EU Retirement Approver</td>
<td>Shantellia Patrice Baker</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EU Retirement Approver</td>
<td>Sue Fillon</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EU Retirement Approver</td>
<td>Sharmel Gonzalez</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Click the “OK” button at this screen.

Your request will be submitted for approval. Emory HR web will generate an e-mail to the Benefits staff. They will review the request and check to see if the employee is eligible to retire and receive retiree benefits.

You will also see a confirmation screen of your entry and you will receive an e-mail confirmation that your request was submitted and when.
Checking Retirements – Approval Status

To check the status of your retirement entry for an employee, return to the Special Update Folder and select Retirement Status. You will see your submitted requests.

Employee Retirement Status

Select a Transaction

The list below contains retirement requests for one employee to view details.

Employee Retirement Requests

<table>
<thead>
<tr>
<th>Name</th>
<th>Empl ID</th>
<th>Empl Rcd</th>
<th>Retirement Date</th>
<th>Workflow Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tweety Bird</td>
<td>9999602</td>
<td>0</td>
<td>08/25/2009</td>
<td>In Approval Process</td>
</tr>
</tbody>
</table>

*Required Field

Return to Select Employees
Return to Special Update
Click the employee name to see the status of the request.

<table>
<thead>
<tr>
<th>Employee Retirement Status</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Retire Employee</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Teresa Bird</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Retirement Details</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Retirement Date:</strong> 08/22/2009</td>
</tr>
<tr>
<td><strong>Reason for Retirement:</strong> Retirement</td>
</tr>
<tr>
<td><strong>Workflow Status:</strong> In Approval Process</td>
</tr>
<tr>
<td><strong>Effective Sequence:</strong> 1</td>
</tr>
</tbody>
</table>

You will receive an e-mail confirmation if the retirement submission is approved and the change will also be visible on the Job Summary page for the employee.

*If the request is denied and the person still leaves employment at Emory, the change must be submitted as a voluntary termination instead.*
Keeping HR/Payroll system HR Web Data Secure – Logging Off

HR Web automatically times out after twenty minutes of keyboard/mouse inactivity.

When you are done with your entry, be sure to click “Sign Out” in the upper right hand corner:

You will be returned to the login screen. To make sure no one can hit the back button or see the history of your transactions, click the File Menu in the upper left corner and select “Close”: 
If at all possible, create a screen saver password to keep HR Web even more secure:

1) Click Start
2) Select Control Panel
3) Select Appearance and Themes or Display
4) Select Choose a Screen Saver
5) Select 10 minutes
6) Click the Power Button
7) Under Advanced Tab, in the Options Box, Select “Always prompt for password when computer resumes from standby”
8) Click Apply button
9) Click OK
HR/Payroll system HR Web Support

- To re-set passwords, contact (404) 727-7777.

- To report problems and data entry errors, or receive assistance:
  - Sherry Stodghill, HRIS Specialist III (404) 727-6066
  - Shauntae Clevelenad, HRIS Specialist II (404) 712-9274
  - Shanterria Baker, HRIS Specialist II (404) 727-0227
  - Susan Newborn, Manager, HR Data Services (404) 727-7563

- Send HRAFs and forms to: Human Resources Data Services, 1599 Clifton Road, Atlanta, GA 30322

- Campus Mailstop = 1599-001-1AP

- HR Data Services Fax: (404) 727-4008
There is no need to submit a HRAF to change employee data if the change is made and SAVED in HR/Payroll system HR Web.

Remember:

- Utilize all appropriate means to keep the data secure
- Refrain from printing data when at all possible. Printed data should be kept in a secure, locked storage unit with restricted access
- Check the accuracy of all your data entry
- Contact Human Resources Data Services immediately if you make a mistake and request that we delete keying errors. You do not have correction mode. Do not keep re-keying over your mistakes!

Special Update Functions (special access permission required)

- Earnings Distributions
- Pay Rate
- Termination
PS Financial Lookups

To find the common PS Financial conversion values for Department #, Default SmartKey, FAS Account and Coda Nominals you will look under Emory HR Web>PS Financial Lookups.

Select the desired conversion option

- Department Id Conversion
- Default SmartKey
- FAS Account Conversion
- Coda Account Conversion
When you select **Department Id Conversion** you will be able to find your former department number and the new value for your department number.

When you select **Default SmartKeys** you will be able to find the Default SmartKey for your department.

When you select **FAS Account Conversion** you will be able to find the 10 digit SmartKey for the former 6 digit FAS Account Number.
When you select **Coda Account Conversion** you will be able to find the 10 digit SmartKey for the former Coda SubAccount.
Payroll & Updates to Account Data

****All job earnings distribution changes to biweekly paid employees must have an effective date of the first day of the pay period (Sunday) in order for the changes to be effective for the first week of the pay period. Failure to use Sunday effective dates for these changes to biweekly employee records will result in data changes that will not be effective until the second week of the biweekly pay period.

If you are unsure of the pay group for an employee, return to the Job Summary screen to check before beginning entry of account changes or Pay Rate Changes.

Updating Earnings Distribution

This function has restricted access based on departmental approval.

To access the earnings distribution update function, return to the Special Update Folder, then select Earnings Distribution. Search for the employee by empl ID, National ID (SSN), or name (Last,First) or Last only) to get the entry screen. If an employee has more than one employee record, you will need to select an employee record from an intermediary page first.
Earnings Distribution
Enter any information you have and click Search. Leave fields blank for a list of all values.

Find an Existing Value

- EmplID: begins with 3993
- Empl Rcd Nbr: = 
- Last Name, First Name: begins with 
- First Name: begins with 
- Last Name: begins with Fudd
- National ID: begins with 

Search Results

<table>
<thead>
<tr>
<th>Empl Rcd Nbr</th>
<th>Last Name, First Name</th>
<th>First Name</th>
<th>Last Name</th>
<th>National ID</th>
<th>Payroll Status</th>
<th>Pay Group</th>
</tr>
</thead>
<tbody>
<tr>
<td>39993071</td>
<td>Fudd Jr, Elmer J</td>
<td>Elmer</td>
<td>Fudd Jr</td>
<td>000003546 Active</td>
<td>EUB</td>
<td></td>
</tr>
<tr>
<td>39993070</td>
<td>Fudd Jr, Elmer J</td>
<td>Elmer</td>
<td>Fudd Jr</td>
<td>000003546 Active</td>
<td>EUB</td>
<td></td>
</tr>
</tbody>
</table>

**** If there is more than 1 row for the same empl record, then pick the row with the latest effective date.

The top half of the page will display the current earnings information:

<table>
<thead>
<tr>
<th>Earnings Distribution</th>
<th>EMP</th>
<th>ID: 9999907</th>
<th>Empl Rcd #: 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department: 021099</td>
<td></td>
<td>University Libraries</td>
<td></td>
</tr>
</tbody>
</table>

**Current Earnings Distribution**

<table>
<thead>
<tr>
<th>Effective Date</th>
<th>Smartkey</th>
<th>Percent of Distribution</th>
<th>Grant End Date</th>
<th>Monthly Rate</th>
<th>Annual Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>05/21/2009</td>
<td>0000001439</td>
<td>10.000</td>
<td>1,926.200</td>
<td>21,902.000</td>
<td></td>
</tr>
<tr>
<td>05/21/2009</td>
<td>0000000446</td>
<td>10.000</td>
<td>202.000</td>
<td>2,433.000</td>
<td></td>
</tr>
</tbody>
</table>

The lower half of the page is the update section:
1) Enter the effective date in this format: MM/DD/YYYY or use the calendar icon to select a date.

If a transaction exists in the HR database with a date later than the one selected, this is the error message you will see:

These earnings distribution changes must be submitted to Human Resources on a Human Resources Action Form!

2) If you are changing the distribution to “Default to Dept Account”, select “Yes”. You will be asked,

*Selecting this button will clear all distribution lines below. Do you want to proceed?* When you select “OK” you will see the following:

3) If you are keeping the same SmartKeys but changing the percentages, just highlight the percent amounts and change the percent amounts.

4) If you are changing the SmartKeys only, click on Select/Edit SmartKey, and enter the 10 digit SmartKey.
5) Enter the percentages of the earnings to be charged to that account (do not use the % sign). You must tab out of the percent field when you are done with entry of a row of data so the system can calculate the total percent.

Your percentages must total 100% upon save or you will get an error message:

6) To add a distribution row, click the plus button next to the row.

7) Enter in the data for the added row(s).
8) To delete a distribution row, click the minus button on the row. Do not use the minus button to delete a row if there is only one row in the record. Instead, add a row for the new data first, and then delete the old row!

9) Tab out of the percent field when you are done with entry of a row of data so the system can calculate the total percent.

10) Don’t forget to click the save button!

11) Your update will be viewable instantly via the job summary view.

NOTE: You may enter a future effective date as long as it is no more than 30 days out from the current date.

Retroactive Changes to Account Data

Enter the effective date in this format MM/DD/YYYY or use the calendar button to select. In Emory HR Web, you may enter a retroactive account change as long as the effective date is not earlier than the effective date of the last data change on the employee record (check Job Summary to be sure).

If the effective date is earlier than the last entry on the employee record, you will not be able to save the entry online. You must submit the change via Human Resources Action Form.

If the effective date you enter is more than 30 days before or after the entry date, but, is allowable for entry, you will get this warning message:

![Warning Message](https://example.com/warning_message.png)
If you get this message, click the OK button and continue. If the account update was retroactive, you will need to do a Retroactive Salary Transfer with the Controller’s Office to transfer the funds as intended.

Make sure your percents add up to 100% and click the save button!

Once you have saved the entry, you will be able to see the changes.

If you have made a mistake, contact Data Services immediately. You do not have correction mode!
Pay Rate Changes & Review Data Updates

Data Entry Tips:

The amount listed for biweekly paid employees should reflect the pay rate per hour worked. Monthly paid employee pay rates should reflect the amount of pay per month.

If you are unsure of the pay group for an employee, return to the Job Summary screen to check before beginning entry of account changes or Pay Rate Changes.

Do not drop an employee’s salary down to zero. This will compromise the Payroll process. Submit a HRAF to change to change the employee status to without compensation (WOC) – limited to faculty and faculty equivalents.

You may enter salary increases or decreases.

Employees are required to have compensation rates reflected in dollars and cents in this format: ##.## (no $).

Compensation rates extend to 6 digits past the decimal point. Be sure your calculations are based on the actual compensation rate in the HR/Payroll system rather than a rounded figure.

If you need to enter more than one pay rate change with the same effective date, such as a merit increase and a market increase, enter one change. Save the change. You will be bounced back to the search screen. Search for the employee again and enter the second pay rate change.

****If you enter more than one type of pay rate change at one time, do not use the percent entry for the second change – the pay rate amount will increase by percent based on the first pay rate change entered, not based on the original pay rate. Make sure the final amount of pay per month or per hour is the correct amount.
The following types of pay rate changes for *staff* must be pre-approved by Human Resources Compensation staff before they may be keyed online:

- Adjustments
- Merits
- Market Adjustments

**Pay Rate Changes**

This function has restricted access based on department approval. You may enter increases or decreases. Some retroactive pay rate changes will also be accepted by the system.

To update an employee’s salary, select:
Emory HR Web>Special Update Folder>Pay Rate Change
Search for the employee using the name, national ID (SSN), or the 7-digit HR/Payroll system employee ID and click the search button:

Pay Rate Change
Enter any information you have and click Search. Leave fields blank for a list of all values.

Find an Existing Value

<table>
<thead>
<tr>
<th>Field</th>
<th>Operator</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>EmpID</td>
<td>begins with</td>
<td>9999903</td>
</tr>
<tr>
<td>Empl ID No.</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Last Name, First Name</td>
<td>begins with</td>
<td></td>
</tr>
<tr>
<td>First Name</td>
<td>begins with</td>
<td></td>
</tr>
<tr>
<td>Last Name</td>
<td>begins with</td>
<td></td>
</tr>
<tr>
<td>National ID</td>
<td>begins with</td>
<td></td>
</tr>
<tr>
<td>From Review Date</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>Thru Review Date</td>
<td>&lt;=</td>
<td></td>
</tr>
</tbody>
</table>

Search | Clear | Basic Search | Save Search Collage

*****If there is more than 1 row for the same empl record, then pick the one with the latest effective date.

The top part of the display will display the current salary data:

Pay Rate Change

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Pepe Lopez</td>
</tr>
<tr>
<td>EMP</td>
<td>EMP</td>
</tr>
<tr>
<td>ID</td>
<td>9999903</td>
</tr>
<tr>
<td>Emp Rec #</td>
<td>0</td>
</tr>
<tr>
<td>Job Code</td>
<td>PF02</td>
</tr>
<tr>
<td>Salary Grade</td>
<td>433</td>
</tr>
<tr>
<td>Comp Rate</td>
<td>$3555.00000</td>
</tr>
<tr>
<td>Annual Rate</td>
<td>$64350.240</td>
</tr>
<tr>
<td>Next Review Date</td>
<td>01/01/2010</td>
</tr>
<tr>
<td>Department</td>
<td>SOM: Medicine: Cardiology</td>
</tr>
<tr>
<td>Min</td>
<td>$42100.000</td>
</tr>
<tr>
<td>Max</td>
<td>$70000.000</td>
</tr>
<tr>
<td>EffDate</td>
<td>06/01/2009</td>
</tr>
<tr>
<td>Review Rating</td>
<td></td>
</tr>
<tr>
<td>Review Date</td>
<td></td>
</tr>
</tbody>
</table>

The bottom half of the display is where the updates will be entered:

Enter the effective date in this format (MM/DD/YYYY) or use the calendar button to select. In HR/Payroll system HR Web 8.9.
Enter a retroactive pay change if the date is not earlier than the effective date of the last data change on the record (check Job Summary to be sure). If the date you enter is earlier than the most recent effective date on the employee record, you will get this error message:

![Error Message]

If you get this message, you need to send the change to Human Resources Data Services via a HRAF.

Click the magnifying glass next to reason code:

**Look Up Reason Code**

Action: PAY
Reason Code: begins with

[Look Up] [Clear] [Cancel] [Basic Lookup]

**Search Results**

<table>
<thead>
<tr>
<th>Reason Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADJ</td>
<td>Adjustment</td>
</tr>
<tr>
<td>MER</td>
<td>Merit</td>
</tr>
<tr>
<td>MKT</td>
<td>Market Adjustment</td>
</tr>
</tbody>
</table>

Select a reason code by clicking on a row below the blue bar.
There are two ways to enter pay rate changes. You may click in the box next to “Amount Calc” to change the pay rate by dollar amount and enter in the new amount under compensation OR you may click in the box next to “Percent Calc” to change the pay rate by a percentage (enter the percent change in the percent box without %).

**Sample Amt Calc Pay Rate Change & Review Data Update**

This type of pay rate change entry enables the user to type in the new hourly or monthly rate of pay:

- Key in the effective date
- Select the reason code
- Click in the Amount Calc Box
- Key in the new hourly or monthly rate and press the Tab key. The % change will appear with the calculated amounts.
- You are required to enter a Next Review Date when changing the salary for any staff member (not faculty).
- You may select the employee’s Performance Review Rating by using the drop-down arrow.
- Be sure to click the “Save” button!
Sample % Calc Pay Rate Change & Review Data Update:

- Key in the effective date
- Select the reason code
- Click in the Percent Calc Box
- Key in percentage of change and press the Tab key. The calculated amounts will appear.
- You are required to enter a Next Review Date when changing the salary for any staff member (not faculty).
- You may select the employee’s Performance Review Rating by using the drop-down arrow.
- Be sure to click the “Save” button!
Updating Review Data Only

To update an employee’s next review date and input an employee’s performance review rating, select:

Emory HR Web>Special Update Folder>Pay Rate Change

1. After searching for and locating the correct employee record:

2. Enter the effective date

3. Do NOT select a Reason Code

4. Click in the box next to Review Only (you will see the reason code auto-populate with the value URD – Update Review Date)

5. Type in the Next Review Date for the employee

6. Select the Performance Review Rating from the drop-down list by placing your mouse on the down arrow.

7. Be sure to Save!
This type of entry will be reflected on the Job Summary page as a Data Change, Update to Review Data with an action code of DTA and a reason code of URD and the effective date specified.

NOTE:

- The performance review rating is visible on the pay rate change page only.
Retroactive Pay Rate Changes

You may enter a retroactive pay change if the date is not earlier that the effective date of the last data change on the record (check Job Summary to be sure).

If the date you enter is earlier than the most recent effective date on the employee record, you will get this error message:

If you get this message, you need to send the change to Human Resources Data Services via a HRAF.

If an employee has been paid incorrectly and is owed salary, you must enter the retroactive change to the compensation rate first, then go to the Finance Division Web site and process a payment request with payroll.
Terminating an Employee

This function has restricted access based on departmental approval.

To access the Terminating Employees function, return to the Special Update Folder and select Terminate Employee.

**Terminate Employee**
Initiate a request to terminate an employee(s).

Instructions
Follow this process to terminate an employee(s):
1. Enter the date the termination will take effect. You will be able to process only those employees that report to you as of this date.
2. Select/Enter a department number or use the search button to search a department(s).
3. Use +/- to add or delete more departments.

Enter the Effective Date
Enter the effective date for this termination.

As Of: 03/01/2003

<table>
<thead>
<tr>
<th>Department</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>160000</td>
<td>HR Administration</td>
</tr>
</tbody>
</table>

Type in the effective date for the termination. Always = first day the employee is no longer an employee, NOT the last date worked.

Type in the department numbers for all the affected departments with employees terminating with this effective date.

All the employees selected must all have the same termination date and termination reason to use this method of entry.

Click the “Continue” button when done selecting departments with employees to terminate on the effective date specified. You will get this next screen:
Terminate Employee

Termination Details

Below is a list of the employees you selected for the reporting change. Click Submit once you have entered the reporting change information.

<table>
<thead>
<tr>
<th>EmpID</th>
<th>Last Name</th>
<th>First Name</th>
<th>Job Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>9999907</td>
<td>Fudd Jr</td>
<td>Elmer</td>
<td>Temporary Employee</td>
</tr>
</tbody>
</table>

**Selected Employees**

**Termination Details**

**Termination Date:** 09/01/2009

Is this date correct? If this is NOT the correct date, click “Return to Select Employees” and follow the instructions for changing the date.

*Reason for Termination:*

Check the termination date on the screen. If it is incorrect, click “Return to Select Employee” link to make the correction.

If the termination date is correct, click the drop-down arrow next to Termination Reason to make your selection.

Remember to click “Submit”
Terminations – Approval Status

Employees terminated with Involuntary Termination Reasons will have the data entry forwarded for approval by Employee Relations before the data will be finalized. Voluntary terminations are immediate and will be saved in real time to the HR/Payroll database and may be verified via the Job Summary view.

<table>
<thead>
<tr>
<th>Involuntary Terminations</th>
<th>Voluntary Terminations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absences or Tardiness</td>
<td>Better Advancement Opportunities</td>
</tr>
<tr>
<td>Misconduct</td>
<td>Better Benefits</td>
</tr>
<tr>
<td>Falsification of Records</td>
<td>Changing Careers/Professions</td>
</tr>
<tr>
<td>Inability</td>
<td>End of Contract</td>
</tr>
<tr>
<td>Insubordination</td>
<td>Death</td>
</tr>
<tr>
<td>Job Abandonment</td>
<td>Lack of Development Opportunities</td>
</tr>
<tr>
<td>Policy Violation</td>
<td>Family Reason</td>
</tr>
<tr>
<td>Reduction in Force – position elimination</td>
<td>Better Work Hours</td>
</tr>
<tr>
<td>Reduction in Force – lack of funding</td>
<td>Commute</td>
</tr>
<tr>
<td>Reduction in Force - reorganization</td>
<td>Unable to Return from Leave</td>
</tr>
<tr>
<td>Refused Transfer</td>
<td>Multiple Concurrent Job</td>
</tr>
<tr>
<td>Resignation in Lieu of Dismissal</td>
<td>Better Pay</td>
</tr>
<tr>
<td>Unsatisfactory Performance</td>
<td>Relocation</td>
</tr>
<tr>
<td></td>
<td>End of Temporary Employment</td>
</tr>
<tr>
<td></td>
<td>Job Did Not Meet Expectations</td>
</tr>
<tr>
<td></td>
<td>Worker's Compensation Settlement</td>
</tr>
<tr>
<td></td>
<td>Dissatisfied with Work Relationships</td>
</tr>
<tr>
<td></td>
<td>Better Working Conditions (physical environment, dept rules/procedures)</td>
</tr>
<tr>
<td></td>
<td>Work Permit Expired</td>
</tr>
<tr>
<td></td>
<td>Organizational Transfer</td>
</tr>
</tbody>
</table>

To check the status of employees terminated with Involuntary Termination Reasons, return to the Special Update Folder and select Termination Status.

1) Click the transaction number to see details.

2) At the top of the display you will see the identifying information for the employee(s).

3) Next, you will see the termination date, termination reason code and status of the request.
4) At the bottom of the display you will be able to see the data on the approval process.

5) When an involuntary termination is approved or denied by Employee Relations, you will receive an e-mail confirmation of the status.
Keeping Emory HR Web Data Secure – Logging Off

The Emory HR Web system will automatically time-out after twenty minutes of keyboard/mouse inactivity.

When you are done with your entry, be sure to click “Sign Out” in the upper right hand corner:

You will be returned to the login screen. To make sure no one can hit the back button or see the history of your transactions, click the File Menu in the upper left corner and select “Close” or click the X in the upper right corner to close the browser.
If at all possible, create a screen saver password to keep HR Web even more secure:

3) Click Start  
4) Select Control Panel  
5) Select Appearance and Themes  
6) Select Choose a Screen Saver  
7) Select 10 minutes  
8) Click the Power Button  
9) Under Advanced Tab, in the Options Box, Select “Always prompt for password when computer resumes from standby”  
10) Click Apply button  
11) Click OK
HR/Payroll System HR Web Support

- To re-set passwords, contact (404) 727-7777.

- To report problems and data entry errors, or receive assistance:
  - Sherry Stodghill, HRIS Specialist III (404) 727-6066
  - Shanterria Baker, HRIS Specialist II (404) 727-0227
  - Shauntae Cleveland, HRIS Specialist II (404) 712-9274
  - Susan Newborn, Manager, HR Data Services (404) 727-7563

- Send HRAFs and forms to: Human Resources Data Services, 1599 Clifton Road, Atlanta, GA 30322

- HR Mailstop = 1599-001-1AP

- HR Data Services Fax: (404) 727-4008

- For online access to forms and manuals for HR Reps: